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Important Notes

●     Previous versions of the VTune(TM) Performance Analyzer MUST BE UNINSTALLED 
prior to installing this version. See the Installation section below for more information.

●     Go to the Intel(R) Software Development Products website to get the latest version of 
the release notes for this product.

Overview

The VTune(TM) Performance Analyzer provides an integrated performance analysis and 
tuning environment that enables you to analyze your code's performance on Intel(R) 
architecture processors of the IA-32 and Itanium(R) processor families.

To receive technical support and product updates, you need to register your purchase with 
Intel. The registration process is described in the Technical Support and Feedback section of 
these Release Notes.

http://www.intel.com/cd/software/products/asmo-na/eng/219327.htm


Additional information on Intel's software performance products is available at http://www.intel.
com/software/products/.

What's New

These are some of the key enhancements and new features introduced in this version:

●     Support for the following processors (for local analysis and on controlling and controlled 
Linux* systems): 

�❍     Intel(R) Core(TM)2 Duo processor
�❍     Intel(R) Core(TM)2 Quad processor
�❍     Dual-Core Intel(R) Xeon(R) processor 5100 Series
�❍     Quad-Core Intel(R) Xeon(R) processor 5300 Series
�❍     Dual-Core Intel(R) Xeon(R) processor 7100 Series
�❍     Intel(R) Pentium(R) D processor 900 Sequence
�❍     Dual-Core Intel(R) Xeon(R) processor 5000 Sequence
�❍     Dual-Core Intel(R) Xeon(R) processor 7000 Sequence
�❍     Dual-Core Intel(R) Itanium(R) 2 processor 9000 Sequence
�❍     Dual-Core Intel(R) Xeon Processor LV
�❍     Intel(R) Quad-Core processor support;

●     32- and 64-bit support for Microsoft* Windows Vista; 
●     32- and 64-bit support for Microsoft Windows Longhorn Server Beta;
●     32- and 64-bit profiling integrated with Microsoft Visual Studio* 2005;
●     Microsoft .NET* 3.0 support;
●     Support for latest Linux* operating systems for remote data collection;
●     Ability to install on systems with non-Intel processors to remotely profile systems with Intel

(R) processors;
●     New events for tuning multi-core processors:  Identify opportunities to improve threading, 

tune multi-core sharing of the bus, and optimize cache-line usage.
●     Double Buffering when sampling a local system. When the sampling buffer is full and 

starts writing data to disk, the second buffer of the same size starts working. It prevents 
from losing samples and improves accuracy of sampling data.

●     Support for latest JDK*: SUN* JDK* 1.6.0, BEA* JDK* 1.6.0 and IBM* JDK* 1.5.0.
●     Call graph profiling of 32-bit applications on 64-bit operating systems.
●     Compatibility with the Linux* Remote Data Collector of Intel(R) VTune(TM) Performance 

Analyzer for Linux* version 9.0 (and later).

 

System Requirements

The VTune(TM) Performance Analyzer is intended to execute on systems that meet the requirements 

http://www.intel.com/software/products/
http://www.intel.com/software/products/


outlined in this section. Supported Development Environments are also detailed in an additional 
subsection below.

NOTE:  
The VTune analyzer supports two usage models, local and remote. The local model 
requires a single system, which is both the system under analysis and the system 
performing the analysis. In the remote model, a data collector is installed on one 
system (the remote system to analyze). The VTune analyzer is installed on the 
controlling system. After collecting data on the remote system, the output of the data 
collection is sent to the controlling system, where it can be viewed.

The following sections list the requirements list the requirements for the systems of both usage 
models. 

Hardware Requirements

The hardware requirements below are for the single system for local analysis and also for the 
controlling system when using an optional second system for remote analysis. In both cases, this 
system is the system upon which the VTune analyzer is installed.

Processors Supported:

●     Servers:

●     Quad-Core Intel(R) Xeon(R) Processor 5300 Series
●     Dual-Core Intel(R) Xeon(R) Processor 5100 Series
●     Dual-Core Intel(R) Xeon(R) Processor 5000 Sequence
●     Dual-Core Intel(R) Xeon(R) Processor 7100 Series
●     Dual-Core Intel(R) Xeon(R) Processor 7000 Sequence
●     Dual-Core Intel(R) Xeon Processor LV
●     Intel(R) Xeon(R) processor MP
●     Intel(R) Xeon(R) processor
●     Dual-Core Intel(R) Itanium(R) 2 processor 9000 sequence
●     Low Voltage Intel(R) Itanium(R) 2 Processor
●     Intel(R) Itanium(R) 2 processor

Desktop:

●     Intel(R) Core(TM)2 Quad processor
●     Intel(R) Core(TM)2 Extreme  processor
●     Intel(R) Core(TM)2 Duo processor
●     Intel(R) Core(TM) Duo processor
●     Intel(R) Core(TM) Solo processor
●     Intel(R) Pentium(R) D processor 900 sequence



●     Intel(R) Pentium(R) D processor
●     Intel(R) Pentium(R) 4 processor Extreme Edition
●     Intel(R) Pentium(R) processor Extreme Edition
●     Intel(R) Pentium(R) 4 processor

Mobile:

●     Mobile Intel(R) Pentium(R) 4 Processor - M
●     Intel(R) Pentium(R) M processor
●     Intel(R) Celeron(R) M processor
●     Intel(R) Celeron(R) D processor
●     Intel(R) Celeron(R) processor
●     Mobile Intel(R) Celeron processor

System Memory Requirements:

At least 128 Megabytes of RAM

Disk Space Requirements:

●     At least 105 Megabytes of available space on a local drive 
●     20 Megabytes of disk space is required for system files on the drive containing the system 

directory (for example, C:\) 

NOTE:  
This additional hard disk space is needed for updating and installing the DLLs and 
OCXs that the VTune analyzer requires to be in the system directory. If you install the 
VTune analyzer on a hard disk other than the drive containing the system directory, 
make sure that you have at least 20 Megabytes free on the drive containing the system 
directory.

Software Requirements

The software requirements below are for the single system for local analysis and also for the 
controlling system when using an optional second system for remote analysis. In both cases, this 
system is the system on which the VTune analyzer is installed.

Free (non-checked) versions of these operating systems:

NOTE:  
In all cases below, use the Microsoft* Windows* recommended virtual memory paging 
file size to prevent unexpected failures of the VTune analyzer.



32-bit operating systems supporting IA-32 processors:

●     Microsoft* Windows XP Professional Service Pack 2
●     Microsoft* Windows Server 2003 Enterprise Edition Service Pack 1
●     Microsoft* Windows Server 2003 R2 Enterprise Edition
●     Microsoft Windows Vista*
●     Microsoft Longhorn Server August 2006 CTP (build 5744)

64-bit operating systems supporting Intel(R) processors with Intel(R) EM64T:

●     Microsoft* Windows XP Professional x64 Edition
●     Microsoft* Windows Server 2003 Enterprise x64 Edition
●     Microsoft* Windows Server 2003 R2 Enterprise x64 Edition
●     Microsoft Windows Vista*
●     Microsoft Longhorn Server August 2006 CTP (build 5744)

64-bit operating systems supporting Intel(R) Itanium(R) architecture processors:

●     Microsoft* Windows Server 2003 Enterprise Edition Service Pack 1

Remote Agent System Requirements for the Remote Usage Model

This subsection describes the requirements for an optional second system capable of performing 
remote sampling and/or remote call graph profiling. 

System Memory and Disk Space Requirements on Remote Machines:

●     At least 128 Megabytes of RAM 
●     At least 20 Megabytes of available space on a local drive 

Hardware Requirements for the Remote Agent System

A system that meets the same hardware requirements as any supported controlling system. See the 
Hardware Requirements section above. 

Operating System Requirements for the Remote Agent System

This section explains the operating system requirements for the Linux* Remote Data Collector.

NOTE:  
If you are not using a default kernel on the supported Red Hat* and SuSE* distributions 
listed below, use the VTune(TM) Performance Analyzer Driver Kit to compile drivers for 
your kernel. The VTune analyzer Driver Kit software is included with this VTune 



analyzer product, and can also be obtained via Intel(R) Premier Support. See Technical 
Support and Feedback section below for more information on the Intel(R) Premier 
Support.

Linux* Distributions Supported 

The Remote Collector for Linux has been tested for operation on the following Linux distributions.  
The kernel versions are supported for Linux systems with supported processors for both 
uniprocessor systems (UP) and multiprocessor systems (SMP), unless otherwise noted:

Operating System Kernel Version IA-32 Intel(R) 
64

Itanium
(R)-based 
systems

Red Hat* Fedora* Core 5 2.6.15-1.2054_FC5 + +  

Red Hat* Fedora* Core 6 2.6.18-1.2798.fc6 + +  

Red Hat* Enterprise Linux* 3.0  
Update 8 2.4.21-47.EL + + +

Red Hat* Enterprise Linux* 4.0  
Update 4 2.6.9-42.EL + + +

Red Hat* Enterprise Linux* 5 2.6.18-8.el5 + + +

SuSE* Linux* Enterprise Server 
(SLES) 9.0 Service Pack 3 2.6.5-7.244 + + +

SuSE* Linux* Enterprise Server 
(SLES) 10.0 2.6.16.21-0.8 + + +

SuSE* Linux*  10 2.6.13-15 + +  

SGI Pro Pack* 4.0, Service Pack 
3 2.6.5-7.244-sn2   +

SGI Pro Pack* 5.0 2.6.16.21-08   +

Red Flag* Linux* 5.0 (Data 
Center) 2.6.9-11.19AX + + +

Miracle* Linux* 4 2.6.9-11.19AX + + +

Haansoft Linux* 2006 Server 2.6.9-11.19AX + + +

Turbo Linux* 10 2.6.9-5.13 + + +



Mandriva / Mandrake Linux* 10.2 2.6.11-6mdk + +  

MontaVista* Linux  Carrier Grade 
Edition 4* 2.6.10 RDC   

Call graph support on different platforms

 Local collection Linux* Remote Data 
Collector

32-bit OS supporting IA-32 
processors Yes Yes

64-bit OS on systems with Intel(R) processors supporting Intel(R) EM64T

64-bit apps Yes Yes

32-bit apps Yes Yes

64-bit OS supporting Intel(R) Itanium(R) architecture processors

64-bit apps Yes Yes

32-bit apps Yes  

Compilers and Development Environments Supported

The VTune analyzer supports applications generated with the following compilers and development 
environments (refer to the VTune analyzer online help for detailed instructions): 

NOTE:  
The Source Level Tuning Assistant is disabled as a default. To enable the Tuning Assistant to 
provide source-based tuning advice: select Configure > Options from the main menu, then select 
Intel(R) Tuning Assistant > Source Information from the Options tree. Uncheck the option 
Disable source-based tuning advice.

Compiler 
Environment

IA-32 
Development 
Environment

Itanium(R) 2 
Processor 

Family 
Development 
Environment

IA-32 
Processor with 
Intel(R) EM64T 
Development 
Environment

Source 
Level 

Tuning 
Assistant 
Specifics

Microsoft* Visual C+
+* 6.0 / .NET + + - for IA-32 

only 



Microsoft* .NET 
Framework* 1.1/ 
2.0/3.0

+ + + -

Microsoft* Platform 
SDK October 2003 - + +

for Itanium 
processor 
family and 

IA-32 
processors 
with Intel 

EM64T only

Microsoft* Visual C#* + - - -

Microsoft* Visual  J#* + - - -

Intel(R) C++ Compiler + + +

for Itanium 
processor 
family and 

IA-32 
processors 
with Intel 

EM64T only

Intel(R) C++ 
Compiler for Linux* + + for source view 

only -

GNU* Project C/C++ 
Compiler for Linux* + - - -

Microsoft* Visual 
Basic* 5.0 / 6.0 / .NET + - - -

Borland* C++ 
Builder* 5.0 + - - for IA-32 only

Borland* C++ 
Builder* 6.0

for source 
view only - - -

Delphi* 5.0 / 6.0 + - - -

IBM* JDK* 1.4.2 / 
1.5.0 (both Windows* 
and Linux*)

+ - - -

Sun* JDK* 1.4.2 / 
1.5.0 / 1.6.0 + Linux* only Sun* JDK* 

1.5.0 / 1.6.0 -



BEA* WebLogic 
JRockit* 1.4.2 / 
1.5.0 / 1.6.0 (both 
Linux* and 
Windows*) 

+ BEA* JRockit* 
1.5.0

BEA* JRockit* 
1.5.0 / 1.6.0 -

Intel(R) Fortran 
Compiler + + -

for IA-32 and 
Itanium 

processor 
family only

Intel(R) Fortran 
Compiler for Linux* + + - -

Installation

Important Notes

All previous versions of the VTune(TM) Performance Analyzer MUST BE UNINSTALLED 
prior to installing this version. This includes data collector installed on a Linux-based system 
for remote data collection from any previous release of the VTune(TM) Performance 
Analyzer. See the Uninstalling VTune analyzer section below for details.

General Installation

●     If you wish to use the Linux* Remote Data collector (vtserver) to profile an application in a 
firewall environment, you need to do the following: 

1.  Set: VTUNE_RDCPORT_IN environment variable before running the VTune analyzer. 
For example:  
set VTUNE_RDCPORT_IN=55555. This setting is communicated to vtserver so 
that it will initiate callback connections only to this port and the next nine ports above it. 

2.  The network administrator must reserve a range of 10 ports for lab outgoing 
connections. In the above example: 55555-55564 

 
●     When installing the VTune analyzer with a counted license, if the VTune analyzer is already 

running as many systems as is permitted by the counted license, the install will display an 
error message that the license is invalid. To work around this issue, close the VTune analyzer 
on one of the systems to free up a license and try installing again. [SCR #17508] 

●     If you are running the evaluation version of VTune analyzer on a multi-user system and it 
unexpectedly reports that the evaluation period for the machine has expired, it is probably 
because another user has already used the allocated evaluation period. Contact Customer 



Support at https://premier.intel.com/ for assistance in running the evaluation version under 
these circumstances. 

●     To preserve global setting changes from previously installed versions of the VTune analyzer, 
copy the file vtenv.stg (located in the ...shared\bin\<username> directory in 
some older versions of the VTune analyzer) to %APPDATA%\VTune. 

●     The VTune analyzer cannot be installed to a network drive. 
●     If you install the VTune(TM) analyzer on a Microsoft* Windows* Server 2003 system using the 

Terminal Server Client to connect to the system and do not reboot the system upon the 
installation program's request, make sure you log off and log on again to the 
system. Otherwise, you may experience problems with the VTune analyzer license file.

●     The VTune analyzer cannot be installed into the %WINDIR%\System32 or %WINDIR%
\SysWOW64 system folders on systems using Itanium(R) processors. [SCR #11705] 

Handling Firewall Issues

The Windows* Firewall (initially introduced in Windows* XP Service Pack 2) may have the following 
implications on how the VTune analyzer accesses the network: 

●     It may block the VTune analyzer from collecting data remotely when the VTune analyzer is 
installed on a system running Windows with the Windows Firewall enabled; 

●     It may block the VTune analyzer from finding the license server (for floating licenses) if the 
license server is located on a system running Windows with Windows Firewall enabled. 

To enable the VTune analyzer accessing the network to operate successfully, do the following:

●     During installation, the VTune analyzer detects the presence of the firewall and requests a 
permission to add a list of executables as exceptions to the firewall settings. Executables in 
the exception list are not blocked by the firewall. You have an option to restrict the exceptions 
to addresses on the local sub-net only or enable them for all remote addresses. If you do not 
add exceptions, the remote features of the VTune analyzer may not work properly. To enable 
proper data collection on Remote Agent systems, remove the address restriction according to 
the location of the remote system(s) on your network. 

Exceptions may not be added to the firewall during installation under the following circumstances:

●     You chose not to allow the installation to add the exceptions; 
●     The Windows Firewall was not installed at the time VTune analyzer was installed; 
●     You run remote collection from within the VTune analyzer integrated into the Microsoft* Visual 

Studio* environment. 

If the VTune analyzer executables were not added to the firewall exceptions list, you may be 
prompted with a security dialog asking whether to block certain programs. When this happens, select 
Unblock this program to allow the remote data collection to proceed. Following are the programs 

https://premier.intel.com/


that may be blocked:

●     When connecting to the VTune analyzer’s Remote Agent installed on Linux: VTune(TM) 
Performance Environment, ATLBistroController Module, and CGExeCtrl Module; 

●     When collecting data remotely from within the Microsoft* Visual Studio* environment there 
may be an additional dialog to block the Microsoft* Visual Studio*. 

Following are situations in which exceptions were not added to the firewall, but no security dialogs 
appear:

●     Remote collection will fail without a security dialog prompt if exceptions were not added to the 
firewall on the system running the Remote Agent. 

●     If a license server is being used, the VTune analyzer will fail during startup with an error 
message indicating that it could not connect to the license server if that server is installed on a 
Windows system with the firewall enabled. 

To resolve operational failures or stop security prompts caused by programs missing from the firewall 
exception list, you can add exceptions manually as follows:

From the Control Panel, click Windows Security Center>Windows Firewall, select Exceptions 
tab and add the programs listed below as exceptions where:

●     <VTuneDir> is the directory where the VTune analyzer is installed; 
●     <VSNetDir> is the directory where Microsoft Visual Studio is installed; 
●     %CommonProgramFiles% is the standard Windows environment variable usually set to 
C:\Program Files\Common Files. 

When your VTune analyzer license is located on a license server, add the following programs as 
exceptions on the system running your license server:

●     %CommonProgramFiles%\Intel\FLEXlm\INTEL.exe 
●     %CommonProgramFiles%\Intel\FLEXlm\lmgrd.intel.exe 

When collecting remote data, add the following programs as exceptions on the Windows system 
running the VTune analyzer:

●     <VTuneDir>\Shared\Bin\VTuneEnv.exe 
●     <VTuneDir>\Shared\Bin\FileCopier.exe 

When collecting remote data from a Linux system, add the following programs as exceptions on the 
Windows system running the VTune analyzer:



●     <VTuneDir>\Shared\Bin\VTuneEnv.exe 
●     <VTuneDir>\Analyzer\Bin\ATLBistroController_LINUX.exe 
●     <VTuneDir>\Analyzer\Bin\CGExeCtrl_LINUX.exe 

When collecting remote data using the VTune analyzer integrated within Microsoft* Visual Studio*, 
also add the following programs as exceptions on the Windows system running Microsoft Visual 
Studio in addition to the exceptions mentioned above:

●     <VSNetDir>\Common7\IDE\devenv.exe 

Make sure these programs have a check mark next to them after being added to the exceptions list.

Uninstalling the VTune Analyzer

There are 2 methods for uninstalling the VTune analyzer.

Method 1:

1.  Go to:  Start menu > Programs > Intel(R) Software Development Tools > Intel(R) VTune(TM) 
Performance Analyzer > Add or Remove Components.

2.  Follow the steps in the Modify/Repair/Remove wizard.

Method 2:

1.  Open the Control Panel (Start > Settings > Control Panel).
2.  Select the Add or Remove Programs applet.
3.  Select Intel(R) VTune(TM) Performance Analyzer then select the Remove button.
4.  Click Yes when prompted. Only the files installed by the VTune analyzer are deleted. Files 

that were created after installation, such as the database files (*.ldb and *.mdb), sampling 
output files, and call graph instrumentation files, are not deleted.

NOTES: 
During the installation process, certain VTune analyzer files (DLLs, EXEs, and OCXs) 
are registered. Registration causes various entries to be added to the Windows* 
Registry. During uninstall, those files, which will no longer be used, are unregistered. 
Nevertheless, it is possible that after uninstall, some unnecessary registry entries may 
remain. While these leftover Registry entries are not harmful to the system, the only 
way to remove them after uninstall is to do so manually. Be advised however that 
Microsoft* warns that incorrect use of the Registry Editor can cause serious problems 
and to use it at your own risk. See the Microsoft* Knowledge Base article 256986 for 
more information. 

http://support.microsoft.com/default.aspx?scid=kb;en-us;256986


Usage

General

●     An extensive subset of the VTune analyzer capabilities is available from the command 
line. Refer to the Online Help for usage instructions.

●     When sampling locally or remotely, the project directory should be a local drive. The VTune 
analyzer may not be able to record samples on a network or a mapped drive. [SCR #17179]

●     To use an alternate symbol path for DBG files define the environment variable: 
_NT_SYMBOL_PATH. For instance, if your files are under D:\support\debug\i386
\symbols\dll\*.dbg, you should set: _NT_SYMBOL_PATH to D:\support
\debug\i386. You can also specify additional symbol directories using Tools > Options > 
Directories property page.

●     The VTune analyzer online help provides descriptions of processor events and instructions. 
To access event descriptions, do the following:

1.  Click the Start button and select Programs (All Programs in Windows* XP).
2.  Select Intel(R) Software Development Tools > Intel(R) VTune(TM) Performance 

Analyzer > Reference.
●     For export to Excel functionality to work, Microsoft* Excel must be installed.
●     To use Sampling Over Time views, you must have the Display sampling results over time box 

checked in the Sampling Configuration dialog box. This is enabled by default.

Pause/Resume APIs do not support multithreaded applications. 

Minimum user rights requirements to work with VTune analyzer

Setting the rights manually

●     To run sampling, your account or any user group it belongs to has to have Profile System 
Performance user right. To add a user right for an account or user group, do the following:

1.  Click Start, click Run, type secpol.msc, and then click OK.
2.  Expand Local Policies, and then click User Rights Assignment.
3.  In the right pane, choose the user right you would like to add and double-click it.
4.  Make sure that the user name or user group you want to have this user right is 

listed.
5.  Click OK.

●     To run Counter Monitor on Windows Server 2003 or Windows Vista, your account has to 
belong to Performance Log Users group. To add an account to a user group, do the 
following:

1.  Click Start, click Run, type compmgmt.msc, and then click OK.
2.  Expand Local Users and Groups, and then click Groups.



3.  In the right pane, choose the user group you would like to add the account to and 
double-click it.

4.  Make sure that the user name you want to add is listed.
5.  Click OK.

 
Setting the rights automatically

elevateUserRight.exe utility can be used by the system administrator to set appropriate rights 
for VTune analyzer users. It is located in <VTuneDir>\Shared\Bin directory where 
<VTuneDir> is the directory where the VTune analyzer is installed.

Using the Linux* Remote Data Collector

This version of the VTune analyzer is fully compatible with the Remote Data Collector of the VTune™ 
Performance Analyzer for Linux version 9.0 (and later). To configure a remote Activity, use the 
Remote Target Configuration dialog box and specify a remote target system (host, user, password, 
port). For more details, refer to the Remote Target Configuration Dialog Box topic in the online help.

In the Remote Target Configuration dialog box, you may specify only the IP address for the remote 
target system. In this case, make sure you set the user name for the remote system in the 
VTUNE_RDC_DEFUSER environment variable. To identify the user name for the remote Linux 
system, the VTune analyzer checks the VTUNE_RDC_DEFUSER environment variable, and then, if 
it is not set up, uses the local (Windows) account name.

Marvell PXA* family of processors Information

As of November 8, 2006, the Intel® Cellular and Handheld Group was acquired by 
Marvell.  Support for the Marvell PXA family of processors based on Intel XScale(R) technology 
is now provided by Marvell. The VTune(TM) Analyzer can still be used to analyze the performance 
of Marvell PXA processors, but two things have changed.

First, the Marvell PXA collector and documentation package must be downloaded separately. 
 Eventually the collectors will be moving to a Marvell hosted web-site, but for now they are available 
in the Intel(R) Registration Center download area with the VTune(TM) analyzer 9.0 for Windows* 
product under the Remote Agent link for the 9.0 release. (These collectors are only required if 
you are using the VTune(TM) analyzer to tune Marvell PXA processors.  Users tuning only non-PXA 
processors should not download the PXA collectors.)

Second, support for the analysis of PXA processors is now being provided by Marvell.  To 
receive a support account, send email to: account_req@support.marvell.com .   Once log-in details 
have been received, log onto the Marvell support website at:  https://support.marvell.com.

Java Support

https://registrationcenter.intel.com/
mailto:account_req@support.marvell.com
https://support.marvell.com/


●     The VTune analyzer supports simultaneous viewing of Win32* and Java* functions in the 
same call graph. Supported versions of Java* environments are detailed in the above table, 
Compiler and Development Environments supported.

●     Remote profiling of Java* applications on Itanium(R) 2-based systems on Linux* has been 
introduced. It is supported via the standard wizard, using its Remote dialog box.

●     IBM* JDK* 1.5.0 does not support the JAVA_TOOL_OPTIONS environment variable. You 
should manually include the -agentlib:javaperf (for sampling) or -agentlib:javaperf=cg (for call 
graph) option to the Java* command line when configuring an Activity in the wizard. [SCR 
#30763].

Microsoft* Visual Studio Support

●     The VTune analyzer plugs into the following versions of Microsoft* Visual Studio*: 
�❍     Microsoft* Visual Studio* .NET 2002
�❍     Microsoft* Visual Studio* .NET 2003
�❍     Microsoft* Visual Studio* 2005

●     Data collection can be directly launched from the Microsoft* Visual Studio  IDE. The VTune 
analyzer can also be launched as an independent tool from the IDE. 

Known Limitations

This section details known limitations in the following categories, General, Collecting Performance 
Data in Batch Mode, Sampling, Linux* Remote Sampling, Call Graph on Windows*, Linux* Remote 
Call Graph, Command-line Interface, Counter Monitor, Static Analysis, and Tuning Assistant. 

General

●     Under certain circumstances, the product may incorrectly identify its version.
●     On systems running Windows* 2003 Server, Service Pack 1, you may have the following 

problems when accessing the VTune(TM) Performance Analyzer help files:
�❍     If you integrate the VTune(TM) analyzer with Microsoft* Visual Studio* during 

installation, links from the VTune analyzer help integrated into Visual Studio to VTune 
analyzer's chm files do not work.

�❍     If topics in the chm files use Dynamic HTML effects, the Microsoft* Internet Explorer 
provides a warning message.

To correct this problem, you must adjust the Security settings of the Internet Explorer 
Internet Options as follows:

�❍     In the Microsoft* Internet Explorer, select Tools >Internet Options
�❍     Click the Security tab



�❍     Click the Custom Level button
�❍     Scroll down to the Miscellaneous section
�❍     Scroll down to the Web sites in less privileged web content zone can navigate into 

this zone and click the Prompt choice.
�❍     Click OK

Using these settings will not make your other websites vulnerable. [SCR #25845]

●     Certain HTML Help features may not work from a remote location after you install Microsoft* 
Windows* XP security update 896358 or security update 890175. To workaround this 
problem, see http://support.microsoft.com/kb/892675.

●     You cannot view results of an Activity if you move a project manually. Use File > Pack and 
Go to properly pack and move the files.

●     The VTune(TM) analyzer cannot pack files that are larger than 2 GB.  [SCR #29391]
●     Packed project files issues:

�❍     Compressed packed project files (.vxp) created with VTune(TM) analyzer for Linux 
version 8.0 or later cannot be unpacked with this product.

�❍     Uncompressed packed project files (.vxp) created with VTune analyzer for Linux 
version 8.0 or later may not unpack correctly when being unpacked with this 
product. Uncompressed packed project files created by a future version of the VTune 
analyzer for Linux should fix this problem. Please check the Release Notes for the 
future version for details. [SCR#25420]

�❍     In the case where a packed Sampling result does not unpack correctly, the .TB5 file 
may be viewed by using the Open File menu item.

●     Projects packed with versions of the VTune analyzer prior to version 6.1 cannot be unpacked 
with the current version. [SCR#7736]

●     You cannot create projects in the %WINDIR%\System32 directory on systems using 
Itanium(R) 2 processors. [SCR #11705] 

●     Function splitting can cause inaccurate results in the sampling view, call graph, or from the 
Tuning Assistant. A function is split when it has multiple non-contiguous relative virtual 
address (RVA) ranges. A compiler can generate split functions for a variety of reasons, usually 
when doing optimizations or for exception handling in C++. For example, using the Intel(R) C/C
++ compiler 7.x and 8.x with the options Qprof_use or Qprof_gen (associated with 
profile guided optimization) often creates split functions. In addition, some exception handling 
routines in C++ may create split function. You can, however, tell the Intel(R) C/C++ compiler 
not to create split functions by using the Qfnsplit- option. A detailed description of this 
issue follows: [SCR #12424] [SCR #12427] 

�❍     When split functions occur from using the Intel(R) C/C++ Compiler, the sampling view 
feature is impacted. Parts of a symbol are considered as separate symbols. So, in a 
sampling view there might be a few records for one symbol. The data itself is valid as a 
sum of all parts. 

�❍     When split functions occur from using the Intel(R) C/C++ Compiler, the call graph 
feature is significantly impacted. The call graph data may be incorrect. 

�❍     The Tuning Assistant is only impacted when the user asks for advice at the hotspot or 
source level. In this case, the advice generated by the Tuning Assistant for split 

http://support.microsoft.com/kb/892675


functions may either be non-existent or partial. This behavior exists for split functions 
that were created by either the Intel(R) C/C++ Compiler or the Microsoft* Visual C/C++* 
Compiler. 

NOTE:  
When using the Intel(R) C/C++ compiler Qipo option, symbol information is lost. 
VTune analyzer features that require symbol information may not work.

●     An extremely long delay can occur (creating the impression of a software hang) when opening 
views containing a large number of entries. Extremely slow response has been reported when 
a view contains tens of thousands of entries. In one case, a drill down view containing 87,000 
entries took over 30 minutes to appear. This is more likely to occur when viewing (sampling) 
Hotspots by RVA or by Functions, especially when a lot of samples with unique addresses 
were collected, or when viewing call graph results of a very large module (for example, 250MB 
module size and symbols). [SCR #12377] [SCR #13943] [SCR #13987] 

●     The online help contains incorrect links to some of the events for the processor code named 
Montecito.  If you run into this problem, perform a manual search for this event to view its 
description. [SCR #25878]

On Windows Vista and Windows Longhorn Server Systems:

●     This release does not support the following:
�❍     Remote data collection with Microsoft* Windows* Vista* and Microsoft Longhorn Server 

operating systems as the controlling systems. 
�❍     Integration into Microsoft* Visual Studio* on Microsoft* Windows* Vista* and Microsoft 

Longhorn Server operating systems.
�❍     Working with non-administrator privileges. You have to be a local administrator to run 

the VTune analyzer. 
●     Sampling driver called sepdrv.sys is not digitally signed. x64 editions of Windows* Vista* 

operating system disable unsigned drivers by default so that it prevents sampling collection. In 
order to enable the driver, reboot the system, press F8 during the boot and select "Disable 
Driver Signature Enforcement". This setting does not persist across boot sessions. 
[SCR#27606]

●     Installation may hang on Windows Longhorn Server during CGExeCtrl.exe and 
CGExeCtrl_LINUX.exe registration. If it hangs, open Task Manager and end hanging 
processes CGExeCtrl.exe and CGExeCtrl_LINUX.exe and continue installation. Some call 
graph features may not work but the rest of features is not affected. [SCR#28662]

On Systems Using Itanium(R) 2 Processors:

●     When running an Activity with the sampling or counter monitor data collector that launches an 
application and has the Terminate Application when Activity ends setting unchecked (a 
setting which may be accessed via the data collector's configuration pages), if the application 
is not stopped manually before the Activity finishes running, some processes associated with 



the VTune analyzer will not terminate after exiting the VTune analyzer. These processes may 
be safely terminated using the Windows* Task Manager. The following process names may 
show up in the Task Manager and should be terminated: FileDialogW64.exe.exe, 
FileSvr64.exe, StandardExeCtrl64PT.exe, vtunecca.exe, and 
VTuneEnv.exe. 

●     Sampling 32-bit Java Virtual Machines or 32-bit .NET execution on Itanium(R) 2 processors is 
not supported in this release. 

On Systems Using Pentium(R) 4 Processors:

When monitoring the event "Streaming SIMD Extensions Input Assists (TI)," note that not all requests 
for assists are actually taken. This event is known to overcount. It counts requests for assists from 
instructions on the non-retired path that do not incur a performance penalty.

On Systems Using Intel(R) Processors with Intel(R) Extended Memory 64 Technology (Intel(R) 
EM64T) with 64-bit Operating Systems Installed:

●     On Intel(R) EM64T system running a 64-bit operating system, the VTune analyzer may not 
remove its paths after every uninstall so that you may run out of environment variable space 
after install/uninstall. If you encounter this problem, you may remove duplicate copies of the 
following directories by hand: C:\Program Files (x86)\Intel\VTune\CGGlbCache; C:\Program 
Files (x86)\Intel\VTune\Analyzer\Bin; C:\Program Files (x86)\Intel\VTune\Shared\Bin; C:
\Program Files (x86)\Intel\VTune\Analyzer\Bin32e; C:\Program Files (x86)\Intel\VTune\Shared
\Bin32e; [SCR#18860] 

Collecting Performance Data in Batch Mode

When using an OLE Automation script (Visual Basic or Perl) to run an Activity comprising sampling 
and counter monitor collectors, some processes associated with the VTune analyzer do not terminate 
after the script exits. The following process names may show up in the Task Manager and may be 
safely terminated: VTuneEnv.exe, vtunecca.exe. [SCR #13990] 

Sampling

Windows* Sampling:

●     Sampling data collection may fail on Itanium(R) 2 Processor Family systems running 
Microsoft* Windows* Server 2003 with Service Pack 1 installed. This is because build 1289 of 
the operating system turned on CPU C-State in the operating system so if the processor is not 
busy, it drops the processor into CPU sleep mode (C-State). C-State can be turned off by 
setting the following registry entry:
[HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Control\Session Manager\Power 
"IdleFrom0Delay"=dword:0 [SCR #23269]



●     The VTune analyzer can only run one sampling session at a time. Attempting to run multiple 
instances of the analyzer with multiple sampling sessions results in a warning being displayed. 
Use the Advanced Activity Configuration option to choose multiple sampling counters 
instead. 

●     You cannot view sampling data in an Activity result containing more than 64 runs. To view 
data from a series of events that normally generate more than 64 runs, split sampling data 
collection into multiple Activities, making sure each Activity generates 64 runs or less. The 
Events tab on the Configure Sampling dialog box (Configure > Modify <Activity> 
Collector...) displays the number of sampling runs that are generated by the selected events. 
[SCR #17086] 

●     Sampling Over Time views display wall clock time on the time axis relative to the wall clock 
time at the start of the sampling session. The wall clock values are computed from the 
processor timestamp counter recorded with every sample collected. On processors with Intel 
SpeedStep(R) Technology, the timestamp to wall-clock conversion is not accurate if the 
processor changes frequency during a sampling session. This results in an incorrect time-axis. 
However, the sample distribution shown in the view is still in order and can still be useful for 
analyzing the performance changes over time. To prevent the processor from changing 
frequencies in Microsoft* Windows*, go to Control Panel > Power Options > Power 
Schemes and change the OS power scheme to Always On. 

●     The Sampling Over Time views can only show sampling data for a single run. If you invoke the 
Sampling Over Time view from sampling results comprised of multiple runs, the view shows 
the data for events collected in the first run. 

Linux* Remote Sampling:

●     The Linux* Remote Data Collector from the VTune analyzer for Linux 8.0 can not be used with 
this product. You must use the Linux* Remote Data Collector that comes with this distribution.

●     The pre-built sampling drivers for IA-32 RedHat* Linux kernels are compiled for kernels with 
hardware type “i686” (e.g., kernel-*-2.6.xyz.i686.rpm). You can check which 
hardware your kernel is built for by typing the command uname –m. If your kernel is built for 
a hardware type different than “i686”, then the pre-built sampling driver may fail to operate. To 
fix this problem, build the sampling driver manually for your kernel by following the instructions 
in /opt/intel/vtune/vdk/src/README. The latest VTune analyzer Driver Kits may 
be downloaded from: http://www.intel.com/software/products/opensource/vdk/.

●     Thread View for sampling data is not supported on Linux. 
●     The VTune analyzer cannot profile 32-bit applications running on a Linux system with an 

Itanium(R) processor. [SCR #10040] 
●     To get tuning advice for function-level code regions for a remote sampling collection on Linux, 

you must drill down from the module view to the HotSpot view while still connected to the 
remote machine. The VTune analyzer copies over the required binary files. If these files 
contain the desired symbol information, the next time the Tuning Assistant is invoked on a 
corresponding module, the advice report contains insights or advice for function-level code 
regions. 

●     In certain cases some events may occur more frequently during sampling than in calibration. 
This can result in very large data files. To overcome this issue, disable calibration or manually 

http://www.intel.com/software/products/opensource/vdk/


set the Sampling After value to a reasonable value to prevent generating too big files but still 
keep the results reliable. [SCR #20782] 

●     If the remote Linux* application to launch is a command-line program that expects user input 
from standard input (stdin), then that application may not be directly launched by vtserver. To 
overcome this issue, use one of the following procedures: 

a.  Run the command-line program manually on the Linux* system (not launched through 
vtserver). 

b.  If the Linux* system is running X Windows*, and vtserver has access to $DISPLAY, 
then the command-line program can be launched indirectly through an xterm. In the 
"Application/Module Profile Configuration" dialog box, specify the remote application to 
launch as follows: 

Filename: /usr/bin/X11/xterm

Command line arguments: –e /path/to/command-line/program 
arg1 arg2...

See the man pages on xterm for further details.

Call Graph

Call Graph on Windows*:

�❍     You may not be able to configure a call graph activity from an activity that was configured from 
a previous version of the analyzer.  If this happens, copy the files from C:\Documents and 
Settings\<user_name>\Application Data\VTune\MasterProjects32 to <Install Dir>/
Analyzer/Bin for IA32 based systems.  For Itanium(R)-based systems copy the files from 
C:\Documents and Settings\<user_name>\Application Data\VTune\MasterProjects64 
to <Install Dir>/Analyzer/Bin.  [SCR #28120] 

�❍     Call graph profiling of ASP .NET applications using a 64-bit operating system on an Intel(R) 
EM64T system may cause the operating system to reboot. The problem is due to the fact that 
the VTune analyzer tries to shutdown some IIS-related services after collection finishes. To 
workaround this problem never agree to terminate processes/services when performing a Call 
graph session for an ASP .NET application. [SCR # 25710]

�❍     Call graph profiling of ASP .NET applications may not work on systems with .NET CLR 2.0 
Beta2 installed. This version of .NET CLR is available on Windows Vista Beta 1 and Windows 
Longhorn Server Beta 1 by default. The application does not start, Internet Explorer shows 
error "Server Application Unavailable". The problem does not appear on released version of .
NET CLR 2.0, hence the workaround is to upgrade the Beta2 version to a released one. [SCR 
#25440]

�❍     Call graph profiling of ASP .NET applications in mixed mode does not instrument native 
modules on 64 bit operating systems running on Intel(R) EM64Tsystems and Itanium(R) 
architecture systems. Therefore, you will only see the results for jit modules. [SCR #25819]

�❍     Call graph support is based on binary instrumentation. There can be several reasons why a 



function may not be instrumented: 
�❍     There is no symbol for the function in the binary. 
�❍     When the optimizing compiler uses jump to call to another function (instead of a call 

instruction), or the same function has multiple entry points. In this case, the two 
functions are treated as one, and only one of the entry points will be instrumented. 

�❍     The first basic block of a function is smaller than 5 bytes. 
�❍     For 64-bit operating systems running on Intel(R) processors with Intel(R) EM64T, the 

module does not have enough free space to insert instrumentation code. 
�❍     Call graph Activities created in VTune analyzer 6.1 cannot be re-run using this version of the 

VTune analyzer. The results can be opened and analyzed successfully, but to get new results, 
you need to recreate the Activity. 

�❍     Applications build with Cygwin* are not supported.  [SCR #26059]
�❍     You cannot profile screen savers (*.scr) on Microsoft* Windows* with call graph. [SCR 

#13858] 
�❍     Profiling binaries with coff format debug info is not supported. This type of binary is produced 

by using the /debugtype:coff linker option. The debug information might not be 
accurate and the instrumented application might crash during run-time. [SCR #14226, 14238, 
14242] 

�❍     When profiling a Windows* Service executable, launch the application outside of VTune 
analyzer using the no-application-to-launch or external launcher modes. Be sure to set the 
service Log-On property to use the account of the user that does the profiling. To do this: 

�❍     Go to Control Panel > Administrative Tools > Services.

�❍     Right-click Services and select Properties.

The <Service Name> Properties dialog box opens.
�❍     Select Log On tab.

�❍     Select This account option and specify the account of the user that does profiling.

To profile out-of-process COM servers or executables launched by Visual Test or a similar testing 
suite with call graph, select No application to launch or some other launch application (remove the 
launch application from the modules of interest) and select Yes in the Force Instrumentation 
column for the profiled executable in the Configure Call Graph dialog box. 

●     When using no-application-to-launch mode or external launcher mode, instrumentation of 
system executables may not work, depending on operating system and version used. The 
reason is that the operating system detects changes in system executables, and restores the 
original executable if someone changes it. 

●     Call graph profiling does not support COM methods profiling on systems using Itanium(R) 2 or 
Intel(R) processors with Intel(R) EM64T with 64-bit operating systems installed. 

●     If a native function is called from managed code, all its native callees will appear as callees of 
the original managed function. [SCR #14743] 



●     Fibers and COM activities are not supported when profiling a DLL in stand-alone-dll mode 
(meaning: only dll modules in the modules of interest list). 

●     When profiling 32-bit applications on systems running Itanium(R) 2 processors and running a 
call graph where there are copies of the same Microsoft* DLLs in both the execution and %
WINDIR%\System32 directories, an error may occur. To prevent this error from 
happening, delete all copies of Microsoft* DLLs in the execution directory so the %WINDIR%
\System32 ones are used instead. [SCR #11173] 

●     In order to profile an ISAPI extension you need to ensure the following: 
�❍     The original non-instrumented extension is unloaded before the beginning. 
�❍     VTune analyzer-generated instrumented extension is unloaded after the end. Perform 

the following steps: 
1.  Open Command Line Windows and run iisreset command in order to restart IIS 

server and unload all loaded extensions. 
2.  Run the VTune analyzer and create call graph project with no application to 

launch and all extension DLLs as modules of interest. 
3.  Run the project. 
4.  Run your benchmark. 
5.  After benchmark has finished open Command Line Windows and run 

iisreset command in order to restart IIS server and unload all loaded 
extensions. 

6.  Press Stop button in the VTune analyzer to stop profiling and view gathered 
profile data. 

●     Call graph data collection is not yet supported using the Windows* command line interface of 
the VTune analyzer. Use the VTune analyzer GUI for call graph data collection instead. 

●     Profiling in dll-level mode using 64-bit operating systems running on Intel(R) processors with 
Intel(R) EM64T is not supported. 

●     Profiling applications with modified Windows compatibility mode is not supported. [SCR 
#20704] 

Linux* Remote Call Graph:

●     The following types of Linux* binaries are not supported: 
�❍     Static Linux* applications that have no symbols 
�❍     The Linux* kernel and any kernel modules 
�❍     The Linux* loader (/lib/ld-Linux*.so*) 

●     When creating an Activity for an application launched from a script, specify the actual 
application as a module of interest. Note the following: 

�❍     Prior to running the VTune analyzer’s remote agent, the LD_LIBRARY_PATH must 
match its value when the application is launched from the script. Otherwise, the remote 
agent may not find the dependent libraries of the application. You may need to add all 
relevant libraries to the path if they are not currently listed there. 

�❍     Before the application of interest is called by the launching script, the application is 
renamed back to its original name. If vtserver is terminated abnormally or seemed to 
hang before the application was called, you need to restore the environment manually. 



(The original application is stored at the same directory with the __bistro_orig 
suffix.) 

●     When an instrumented application calls the exec system call, the whole image context is 
replaced with the new image. If the application calls to exec with original name of the 
instrumented image, then the instrumented image is used. In the other cases, the original (non-
instrumented) image is called, and no results will be generated from this point in the run. 

●     Linux* call graph does not support setuid images. The setuid mechanism is used to give a 
user process the effective user ID of another user, usually root. You can use call graph and 
run the setuid executable only if you are logged in as the same user as the owner of the setuid 
executable. 

●     Call graph results are written during the regular termination procedure of the process. This 
means that if the process did not terminate properly, no call graph results will be generated. 
There are a few reasons why an application may not terminate properly: 

�❍     There was some type of crash (like an access violation) during the termination 
procedure. 

�❍     The application terminated because a termination signal was caught by the application. 

To generate call graph results in the above three cases, you need to cause a proper 
termination before it is improperly terminated by itself. There are two ways to perform a proper 
termination:

�❍     Press the Stop button in the GUI. 
�❍     In the Linux* machine you can send a special signal to the instrumented application. 

The number of the signal should be in the _Bistro_Exit_Signal_ environment 
variable, or the SIGUSR2, by default. 

●     Call graph implements the same search algorithm as the standard loader for locating 
executables and shared objects. Therefore, if you use a private version of the loader with a 
different search algorithm, call graph may not find the required files. 

●     Call graph supports dynamically loaded images loaded with dlopen (from libdl). There is no 
support to images loaded directly with the mmap system call. 

●     VTune analyzer may hang if a non-existing module of interest was specified when creating a 
call graph Activity. [SCR #19801] 

●     The call graph run creates Unix* pipes and uses file locking on the Linux* file system. 
Therefore the Linux* file system on which the cache directory resides must support these 
operations. Intel recommends using a local disk for the call graph cache directory on the 
Linux* system. 

●     The NFS automount utility (also known as the amd) may unmount directories specified in the 
call graph collection but not used continuously during the run. This may cause unexpected 
behavior and the VTune analyzer may fail to run or generate results. Try to avoid using 
automounted directories. If your Linux* system uses automounted directories, turn off 
automount and manually mount any necessary directories before running a call graph session. 

●     Call graph results from Linux* remote system are collected and stored in memory on the 
Windows* local system. In some cases, the required memory may exceed the available 
physical memory. To limit the amount of memory used during the run, select Configure > 
Options > Call Graph and change the memory setting in the dialog box. Te maximum call 



graph results size is limited to about 800Mb. Set the system virtual memory size as large as 
possible. 

●     Statically linked executables are not fully supported. You may see problems, especially when 
C++ exception handling is used. To avoid this problem, dynamically link your application for 
call graph profiling. 

●     The call graph information of an application is kept in memory during the run. The buffer size 
is set by default to 128MB unless your system has less then 256MB - then it will be half of the 
physical memory. Setting other value to the buffer size can be done using Configure > 
Options > Call Graph > Collector property page. 

●     Call graph does not support applications that use two different shared objects with the same 
name, even if they are located in different directories. This may cause an abnormal 
termination of the VTune analyzer. [SCR #14986] 

●     If you packed an Activity result of the call graph data collection and try to unpack and run it on 
another controlling system, be sure you re-launched vtserver on a Remote Agent system. 
Otherwise, the error can occur on the controlling system. [SCR #21236]  

Command Line Interface

●     When using any of the VTune analyzer commands, the total length of any pathname and 
filename combination cannot exceed 250 characters due to a limitation in the database. [SCR 
#15423] 

●     VTL global option symbol_search_dirs does not work on systems using Itanium(R) 2 
processors and Intel(R) processors with Intel(R) EM64T running a 64-bit operating system. 
[SCR #20983] 

Counter Monitor

●     Counter monitor under Windows Server 2003 with Power User privileges may not work, 
saying that: "The performance system on this computer does not work properly; some 
performance objects can’t be initialized. Registry corruption could be a possible reason." In 
case you see this error, run counter monitor with Administrator privileges. 

Static Analysis

●     Static analysis is not supported on Itanium(R) 2 processors. [SCR #12400] 
●     You may see mismatches between functions and source files in Static Module View for 

binaries containing Microsoft* .NET Common Language Runtime functions. [SCR #11650] 
●     In the Source View static analysis, the Activity result displayed does not affect the default 

processor in the Change Processor context menu. The default processor is set as the host 
processor type. If the module is for a different processor architecture than that of the host, the 
default processor is set as the latest processor in the architecture family. [SCR #14267] [SCR 
#12407]

Tuning Assistant



●     The Tuning Assistant only supports tuning advice for the following processors: 
�❍     Intel(R) Pentium(R) 4 processor 
�❍     Intel(R) Pentium(R) M processor 
�❍     Intel(R) Core(TM) Solo processor 
�❍     Intel(R) Core(TM) Duo processor 
�❍     Intel(R) Core(TM)2 Duo Processor 
�❍     Dual-Core Intel(R) Xeon(R) Processor 5100 Series 
�❍     Intel(R) Itanium(R) 2 processor 

●     The Tuning Assistant may report errors related to source-based advice generation when 
invoked from Source View when the source code uses advanced features of Microsoft* Visual 
C++* .NET. To work around this problem, disable source-based advice in the Intel(R) Tuning 
Assistant / Source Information section of the Options (Configure > Options) dialog box. 

●     The Tuning Assistant doesn't support comparing two different binaries in the HotSpot or 
Source View. The Tuning Assistant will continue generating invalid messages, or none at all. It 
generates the following error message: "A valid comparison cannot be made because the 
RVA values selected in these views will not correlate to the same functions in the two different 
binaries." To avoid this problem, only request advice from the Process or Module Views when 
comparing two different binaries. 

●     MOB Replays Retired may not report correct data in precise mode. Precise mode is enabled 
by default for this event. To disable precise mode, add it to the Select Events list and 
uncheck the Precise Event checkbox. Then simply double-click the event. 

●     Occasionally, when Automatically generate tuning advice is selected in the sampling 
wizard, after sampling data collection finishes, the Tuning Assistant may report "No Sampling 
data for the selected context". When automatically generating tuning advice, the Analyze the 
current selection option is selected by default in the Tuning Assistant Options for 
Sampling dialog. This causes the Tuning Assistant to try to analyze samples that were 
collected in the process that was selected in Application to launch (in the Sampling Wizard) 
and in modules that were selected in the modules of interest list (in the Sampling Wizard). If 
this combination of process and modules did not receive any samples, the "No Sampling data 
for the selected context" error message will be generated. (For example: this may occur when 
the Application to launch is a script that invokes the actual application containing the 
modules of interest). In this case, after sampling data is collected, select the processes and/or 
modules for which you would like advice, then manually invoke the Tuning Assistant (by 
pressing F8 or selecting Get Tuning Advice from the View menu). 

●     After zooming in to a specified time range in Sampling Over Time View, switching to Classic 
Sampling View, and invoking the Tuning Assistant, the resulting Tuning Assistant report is for 
the entire workload time range, not the specified zoom-in time range. 

●     Getting tuning advice for imported results is not supported [SCR #17452] 

Technical Support and Feedback

Register with Intel(R) Premier Support 



To receive technical support for the tools provided in this product and technical information including 
FAQs and product updates, register for an Intel(R) Premier Support account on our secure web site, 
https://premier.intel.com/, if you have not already registered. Click Obtaining Technical Support on 
that site to start the registration.

NOTE:  
Registering for support varies for release product or pre-release products (alpha, beta, 
etc.) and only released products have support web pages on http://support.intel.com/. 

To register for an account, visit the Intel(R) Registration Center web site at Intel Registration Center. 
If you have forgotten your password, please submit a request to: Startup Support. Do not email 
technical issues using this mechanism because it is not secure.

Self-Help and User Forums

Intel provides a rich repository of online self-help product information, such as tutorials, getting 
started tips, known product issues, product errata, compatibility information and answers to 
frequently asked questions. 

Accessing Intel(R) Software Development Products Technical Support:

The Intel(R) Software Development Products: Technical Support Web site is a wealth of information. 

http://www.intel.com/software/products/support/

It's a great place to find answers quickly and to gain additional insight in using our products 
effectively. 

Accessing VTune(TM) Performance Analyzer Product Support:

The VTune analyzer product support web site provides access to technical issues, frequently asked 
questions, product documentation and product errata.

http://support.intel.com/support/performancetools/vtune/

Accessing the VTune(TM) Performance Analyzer Development Forum:

Users of the VTune analyzer software are invited to participate in open forum discussions regarding 
this and other VTune analyzer software, ranging from non-technical to highly technical in nature, at 
the Intel(R) Developer Services Forums. 

http://softwareforums.intel.com/ids

https://premier.intel.com/
http://support.intel.com/
https://registrationcenter.intel.com/
https://registrationcenter.intel.com/support/contact.aspx
http://www.intel.com/software/products/support/
http://support.intel.com/support/performancetools/vtune/
http://softwareforums.intel.com/ids


The forums are moderated, but all discussions regarding VTune analyzer experiences are invited, 
including functionality, usability, bug workarounds and general usage.

Submitting Issues

Your feedback is important to us. To submit an issue via the Intel(R) Premier Support web site: 

1.  Go to https://premier.intel.com/. Java* and JavaScript* must be enabled in your web browser 
to submit an issue. 

2.  Type in your Login and Password. 
3.  Click the Submit button. 
4.  Read the Confidentiality Statement and click the I Accept button. 
5.  Click on the Submit Issue link in the left navigation bar. 
6.  Choose Initiatives, technologies & tools from the Product Type drop-down list. 
7.  Choose VTune(TM) Performance Analyzer from the Product Name drop-down list and 

specify 8.0.2 as the version in the appropriate field.
8.  Enter your question and complete the fields in the windows that follow to successfully submit 

the issue. 
a.  Describe the problem or enter your suggestion. For problem reports, be as specific as 

possible, so that we may reproduce the problem. For compiler problem reports, include 
the compiler options and a small test case, if possible. 

b.  Describe your system's configuration information. Be sure to include information 
applicable to your setup: the operating system name, version and build number, the 
name and version number of installed applications, and anything other information that 
will help us to address your concern(s). 

A technical support engineer will respond within one (1) Intel business day.

Documentation

The documentation for the VTune analyzer for Windows* is presented in several different formats: 
the online Getting Started Tutorial, online help, Portable Document Format (PDF) versions of 
manuals and HTML documentation. 

Getting Started Tutorial

The Getting Started Tutorial shows you how to get started using the VTune analyzer to help you 
optimize your application's performance. After taking this tutorial, you should be able to: 

●     Understand the basic concepts and terminology. 
●     Start using the VTune analyzer to analyze your application's performance. 

https://premier.intel.com/


To access the tutorial, click the Start button and from Programs (or All Programs in Windows* XP), 
select Intel(R) Software Development Tools > Intel(R) VTune(TM) Performance Analyzer > 
Getting Started Tutorial.

To view the tutorial, use Netscape* Communicator 4.x, Netscape 6.2 or higher, or Microsoft* Internet 
Explorer 4 or higher. If using Mozilla*, certain pop-ups may not work.

Online Help

Complete information on using the VTune analyzer is contained in the VTune analyzer online help. 
This help is in HTML Help 1 format and can be viewed in an HTML Help viewer. When the VTune 
analyzer is integrated in the Microsoft* Visual Studio* .NET environment, a small Help 2 module titled 
VTune(TM) Performance Tools is available from the Microsoft* Visual Studio* .NET Help collection. 
This module covers key VTune analyzer concepts and has links to topics in the main online help in 
the HTML Help 1 format. 

Access the online help from the Help menu, or access the context-sensitive help in one of the 
following ways: 

●     Right-click an item in a dialog box or view and select What's This? 
●     Hit the F1 key to display the overview help topic corresponding to the active VTune analyzer 

window. From the overview help topic, you can navigate to related help topics. 
●     Go to Start > Programs > Intel(R) Software Development Tools > Intel(R) VTune(TM) 

Performance Analyzer and select one of the available help files in the program groups.

NOTE: 
If the Microsoft* Internet Explorer cumulative security patch has been installed on your system, you 
may not be able to view or use certain help features, for example, buttons in the online help may 
appear as missing images. To resolve this problem, read the Microsoft* Knowledge Base article 
822989 and install the necessary updates.

HTML Documentation

The VTune analyzer for Windows* HTML documentation consists of these Release Notes, 
installation instructions for the VTune(TM) Performance Analyzer Linux* Remote Agent, and the 
VTune analyzer Online Help. 

Viewing HTML documents:

The HTML documents included on the product CD-ROM can be viewed using any browser, although 
a browser that supports HTML 4.0 is recommended. Older versions of browsers (especially 
Netscape* and Konqueror*) may not display some of the HTML documents correctly. 
  

http://support.microsoft.com/default.aspx?scid=kb;en-us;822989


Additional Information 

Related Products and Services

Information on Intel(R) software development products is available at http://www.intel.com/software/
products. Visit the following product-related sites for additional information: 

●     The Intel(R) Software College provides interactive tutorials, documentation, and code samples 
that teach Intel(R) architecture and software optimization techniques. 

●     The Intel(R) C++ Compiler and Intel(R) Fortran Compiler enable software to run at top speeds 
and fully support the latest Intel(R) IA-32 and Itanium(R) processors. 

●     The Intel(R) Performance Library Suite provides a set of routines optimized for various Intel(R) 
processors. It is not part of this product. 

●     The Intel(R) Math Kernel Library provides developers of scientific and engineering software 
with a set of linear algebra, fast Fourier transforms and vector math functions optimized for the 
latest Intel(R) Pentium(R) and Intel(R) Itanium(R) processors. 

●     The Intel(R) Integrated Performance Primitives consists of cross platform tools to build high-
performance software for several Intel(R) architectures and several operating systems. 

Disclaimer and Legal Information

INFORMATION IN THIS DOCUMENT IS PROVIDED IN CONNECTION WITH INTEL(R) 
PRODUCTS. NO LICENSE, EXPRESS OR IMPLIED, BY ESTOPPEL OR OTHERWISE, TO 
ANY INTELLECTUAL PROPERTY RIGHTS IS GRANTED BY THIS DOCUMENT. EXCEPT 
AS PROVIDED IN INTEL'S TERMS AND CONDITIONS OF SALE FOR SUCH PRODUCTS, 
INTEL ASSUMES NO LIABILITY WHATSOEVER, AND INTEL DISCLAIMS ANY EXPRESS 
OR IMPLIED WARRANTY, RELATING TO SALE AND/OR USE OF INTEL PRODUCTS 
INCLUDING LIABILITY OR WARRANTIES RELATING TO FITNESS FOR A PARTICULAR 
PURPOSE, MERCHANTABILITY, OR INFRINGEMENT OF ANY PATENT, COPYRIGHT OR 
OTHER INTELLECTUAL PROPERTY RIGHT.  
UNLESS OTHERWISE AGREED IN WRITING BY INTEL, THE INTEL PRODUCTS ARE NOT 
DESIGNED NOR INTENDED FOR ANY APPLICATION IN WHICH THE FAILURE OF THE 
INTEL PRODUCT COULD CREATE A SITUATION WHERE PERSONAL INJURY OR DEATH 
MAY OCCUR. 
Intel may make changes to specifications and product descriptions at any time, without notice. 
Designers must not rely on the absence or characteristics of any features or instructions 
marked "reserved" or "undefined." Intel reserves these for future definition and shall have no 
responsibility whatsoever for conflicts or incompatibilities arising from future changes to them. 
The information here is subject to change without notice. Do not finalize a design with this 
information.  
The products described in this document may contain design defects or errors known as errata 

http://www.intel.com/software/products
http://www.intel.com/software/products
http://www.intel.com/software/college/
http://www.intel.com/software/products/compilers/
http://www.intel.com/software/products/perflib/
http://www.intel.com/software/products/mkl/mkl52/
http://www.intel.com/software/products/ipp/


which may cause the product to deviate from published specifications. Current characterized 
errata are available on request.  
Contact your local Intel sales office or your distributor to obtain the latest specifications and 
before placing your product order. 
Copies of documents which have an order number and are referenced in this document, or 
other Intel literature, may be obtained by calling 1-800-548-4725, or by visiting Intel's Web Site. 

Intel processor numbers are not a measure of performance. Processor numbers differentiate 
features within each processor family, not across different processor families. See http://www.
intel.com/products/processor_number for details.

BunnyPeople, Celeron, Celeron Inside, Centrino, Centrino logo, Core Inside, FlashFile, i960, 
InstantIP, Intel, Intel logo, Intel386, Intel486, Intel740, IntelDX2, IntelDX4, IntelSX2, Intel Core, 
Intel Inside, Intel Inside logo, Intel. Leap ahead., Intel. Leap ahead. logo, Intel NetBurst, Intel 
NetMerge, Intel NetStructure, Intel SingleDriver, Intel SpeedStep, Intel StrataFlash, Intel Viiv, 
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PDCharm, Pentium, Pentium Inside, skoool, Sound Mark, The Journey Inside, VTune, Xeon, 
and Xeon Inside are trademarks of Intel Corporation in the U.S. and other countries.
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